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1 Summary of Changes 

This section describes the changes to this document for each release and document 
version. 

1.1 Changes to Release 17.0, Document Version 1 

This version of the document includes the following changes: 

�  Updated section 9.6 Search Directory for the Keyword Search Starts With 
Enhancement Functional Specification (EV93865). 

�  Updated section 6.4.2.3 Queues Tab for EV 100521. 

�  Updated section 13.6 Control Keys for EV 109479 and EV 110095. 

1.2 Changes for Release 16, Document Version 2 

This version of the document includes the following changes: 

�  Updated section 4 Logging In for EV 98624. 

1.3 Changes for Release 16, Document Version 1 

This version of the document includes the following changes: 

�  Updated section 7.5.4 Transfer to Voice Mail for EV 90437. 

�  Added section 7.1.4 Dial from Call History for the Click to Call from Call Logs 
Functional Specification. 

�  Modified section 6.4.2.5 Messaging Tab (Enterprise Edition) for the Secure SMTP 
Support Functional Specification. 

�  Modified sections 9.5 Filter Directory Alphabetically (Enterprise Edition), 9.6 Search 
Directory, and 9.7 Create Custom Directory from Search Results (Enterprise Edition) 
for the Display Text Search In The Search Field When Inactive Functional 
Specification. 

�  Updated sections 5.4.2 Directory Management Interface and 9.6 Search Directory for 
EV 92916. 

�  Updated section 7.3 Put Call on Hold for EV 91540. 

�  Updated sections 7.5.2 Conduct Supervised Transfer, 7.5.3 Conduct Consulted 
Transfer, and 7.5.4 Transfer to Voice Mail for EV 91541. 

�  Updated image in section 5.4.2 Directory Management Interface for EV 88662. 

�  Updated section 4 Logging In and removed the section about the Tools�  Options �  
Updates tab for the Web-based/Web-Services-based Receptionist and Call Center 
Client Applications Functional Specification. 

�  Updated sections 7.5.6 Busy Camp On (Enterprise and Small Business Editions), 7.7 
Conduct Directed Call Pickup, and 7.8 Barge-in for the Barge-In and Camp On with 
Full DN Enabled Functional Specification. 
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�  Updated for EV 98624. 

1.4 Changes for Release 14.sp6, Document Version 3 

This version of the document includes the following changes: 

�  Deleted superfluous text at the beginning of section 3.3 Receptionist Small Business. 

�  Modified section 9.9 Manage Speed Dial Entries for EV 84052 and corrected section 
9.8 Edit Contact Notes (Enterprise Edition). 

1.5 Changes for Release 14.sp6, Document Version 2 

This version of the document includes the following changes for EV 67940: 

�  Added information about Receptionist Enterprise, Small Business, and Office. 

�  Reorganized the guide to clearly identify the functionality available in each version. 

�  Added the Summary of Changes section to this document. 
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2 About This Guide 

This guide provides step-by-step procedures and reference information for Receptionist 
Release 17.0, which exists in three editions:  Receptionist Enterprise, Receptionist Small 
Business, and Receptionist Office. 

���� �����������	
���
�������
���
���������������������
 ���
�������
���

2.1 Audience 

This document is intended for end users of Receptionist Enterprise, Small Business, and 
Office. 

2.2 How This Guide is Organized 

Section 3 Receptionist Overview gives an overview of Receptionist and lists the 
functionality for each edition. 

The rest of this document provides a detailed description of Receptionist functionality, 
clearly identifying functions that are specific to a particular edition.  For example, the 
section describing the Queue panel, which is available only in Receptionist Enterprise, is 
tagged as follows: 

5.3 Queue Panel ( Enterprise Edition ) 

If a section or feature does not specify a version of Receptionist, it applies to all editions. 

2.3 Additional Resources  

For Application Server procedures used by group administrators, department 
administrators, and users, see the following BroadWorks guides: 

�  BroadWorks Application Server Group Web Interface Administration Guide  
Parts 1 and 2 

�  BroadWorks Getting Started Web Interface Administration Guide 

�  BroadWorks Application Server User Web Interface Administration Guide 

�  BroadWorks CommPilot Call Manager User Guide 
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3 Receptionist Overview  

BroadWorks Receptionist is a carrier class Internet Protocol (IP) Telephony Attendant 
Console, specifically developed for hosted environments.  It is used by “front-of-house” 
receptionists or telephone attendants, who screen inbound calls for enterprises.  
BroadWorks Receptionist realizes the promise of IP Telephony by enhancing business 
processes and delivering rich services in a user-friendly way. 

BroadWorks Receptionist delivers the following real benefits to users: 

�  An elegant design that is aesthetically pleasing 

�  An ergonomic design that follows the natural work “flow” of a call from the top to the 
bottom of the screen 

�  Improved business processes as only “valid” options are presented to the attendant 

�  Professional call handling as critical information is available in “real time” 

�  Accurate delivery of messages through a one-step process when people are 
unavailable 

Along with this focus on design, BroadWorks Receptionist employs the latest technology 
platforms and communications facilities. 

3.1 Receptionist Editions  

Receptionist exists in three editions:  Enterprise, Small Business, and Office, each tailored 
to the specific needs of its target users. 

The following sections provide an overview of the Receptionist Enterprise, Small 
Business, and Office interface and functionality and refer you to other sections of the 
document for more information. 

���� ����������
����������������
��
���
����
����������� ������������������������������������������



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 16 OF 119�

3.2 Receptionist Enterprise   

The Receptionist Enterprise edition is a BroadWorks full-featured client, designed to 
support the needs of front office personnel in any environment.  It supports the full set of 
call control options, large-scale line monitoring, queuing, multiple directory options and 
views, Outlook integration, and other features required in large or distributed 
organizations. 

3.2.1 User Interface  

Figure 1 shows the main interface of Receptionist Enterprise. 

 

������������
�������
����������
������� ������
��

The interface contains the following work areas: 

1.  Switchboard panel 

2.  Company Notes and Profile area 

3.  Queue panel 

4.  Contact Directory panel 

5.  Alphabetical Index filter 

6.  Options panel 

7.  Control panel 

For more information on these areas, see section 5 Receptionist Interface and Setup. 
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The interface also contains the following: 

�  Title bar – Displays the name of your version of Receptionist. 

�  Menu bar – Contains menu items used to configure various settings and provide 
information about Receptionist. 

The menu items are described in section 6 Menu Bar. 

The menu items that contain information specific to Receptionist Enterprise are as follows:  
Tools – Options, Tools – Call History, View – Company Information, and View – 
Directories.  They are shown in the following figures. 

Figure 2 shows the Receptionist Enterprise Tools – Options dialog box. 
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The Tools – Options dialog box provides the following tabs: 

�  General 

�  Connections 

�  Queues 

�  Day/Night Mode 

�  Messaging 

�  Directories 
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-  LDAP Integration 

-  Outlook Integration 

�  Theme 

�  Updates 

�  About 

For more information, see section 6.4.2 Tools �  Options. 

Figure 3 shows the Receptionist Enterprise Tools – Call History dialog box. 
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The Tools �  Call History dialog box provides the following tabs: 

�  Dialed Calls 

�  Received Calls 

�  Missed Calls 

�  Other 

For more information, see section 6.4.1 Tools – Call History. 

Figure 4 shows the Receptionist Enterprise View menu. 
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The View menu allows you to configure visibility of certain Receptionist elements and 
contains the following items: 

�  Company Information 

�  Queue 

�  Queue Columns 

�  Directories 

For more information, see section 6.2 View Menu. 

3.2.2 Call Management Functionality  

The Receptionist Enterprise provides the following call management functions: 

Function Described in Section 

Dial Contact 7.1.1 Dial Contact 

Dial Ad Hoc Number 7.1.2 Dial Ad Hoc Number 

Speed Dial 7.1.3 Speed Dial 

Dial From Call History 7.1.4 Dial from Call History 

Answer Call 7.2 Answer Call 

Hold Call 7.3 Put Call on Hold 

Unhold Call 7.3.2 Unhold Call 

End Call 7.4 End Call 

Blind Call Transfer 7.5.1 Blind Transfer Call 

Supervised Call Transfer 7.5.2 Conduct Supervised Transfer 

Consulted Call Transfer 7.5.3 Conduct Consulted Transfer 

Transfer to Voice Mail 7.5.4 Transfer to Voice Mail 

Transfer to Queue 7.5.5 Transfer to Queue (Enterprise Edition) 

Busy Camp On 7.5.6 Busy Camp On (Enterprise and Small Business Editions) 
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Function Described in Section 

Group Call Park 7.6 Conduct Group Call Park (Enterprise Edition) 

Directed Call Pickup 7.7 Conduct Directed Call Pickup 

Operator Call Barge-in 7.8 Barge-in on a Call  

Start Conference Call 7.9.1 Start Conference Call 

Hold Conference Call 7.9.2 Hold Conference Call 

Unhold Conference Call 7.9.3 Unhold Conference Call 

Leave Conference Call 7.9.4 Leave Conference Call 

End Conference Call 7.9.5 End Conference Call 
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3.3 Receptionist Small Business   

The Receptionist Small Business edition is a lower-priced version of the client, targeted at 
front office personnel in small and mid-sized organizations that do not require multiple 
directories, call queuing, or other advanced features.  It supports a full set of call control 
functions and monitoring of up to 30 lines in the directory. 

3.3.1 User Interface  

Figure 5 shows the main interface of Receptionist Small Business. 
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The interface contains the following areas: 

1.  Switchboard panel 

2.  Directory panel 

3.  Options panel 

4.  Control panel 

For more information, see section 5 Receptionist Interface and Setup. 
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The Receptionist Small Business interface also contains the following: 

�  Title bar – Displays the name of your version of Receptionist. 

�  Menu bar – Contains menu items used to configure various settings and provide 
information about Receptionist. 

These menu items are described in section 6 Menu Bar. 

The menu items that contain information specific to Receptionist Small Business are as 
follows:  Tools – Options, Tools – Call History, View – Company Information, and View – 
Directories.  They are shown in the following figures. 

Figure 6 shows the Receptionist Small Business Tools – Options dialog box. 
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The Tools – Options dialog box provides the following tabs: 

�  General 

�  Connection 

�  Day/Night Mode 

�  Directories 

�  Theme 

�  Updates 
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�  About 

For more information, see section 6.4.2 Tools �  Options. 

Figure 7 shows the Receptionist Small Business Tools – Call History dialog box. 
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The Tools �  Call History dialog box provides the following tabs: 

�  Dialed Calls 

�  Received Calls 

�  Missed Calls 

For more information, see section 6.4.1 Tools – Call History. 

Figure 8 shows the Receptionist Small Business View menu. 
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The View menu allows you to select directories you want to access from the Contact 
Directory panel. 

For more information on the View menu, see section 6.2 View Menu. 

3.3.2 Call Management Functionality  

This section lists call management functions of Receptionist Small Business and provides 
you with pointers to sections of this document where they are described: 

Function Described in Section 

Dial Contact 7.1.1 Dial Contact 

Dial Ad Hoc Number 7.1.2 Dial Ad Hoc Number 

Speed Dial 7.1.3 Speed Dial 

Dial From Call History 7.1.4 Dial from Call History 

Answer Call 7.2 Answer Call 

Hold Call 7.3 Put Call on Hold 

Unhold Call 7.3.2 Unhold Call 

End Call 7.4 End Call  

Blind Call Transfer 7.5.1 Blind Transfer Call 

Supervised Call Transfer 7.5.2 Conduct Supervised Transfer 

Consulted Call Transfer 7.5.3 Conduct Consulted Transfer 

Transfer to Voice Mail 7.5.4 Transfer to Voice Mail 

Busy Camp On 7.5.6 Busy Camp On (Enterprise and Small Business Editions) 

Directed Call Pickup 7.7 Conduct Directed Call Pickup 

Operator Call Barge-in 7.8 Barge-in on a Call 

Start Conference Call 7.9.1 Start Conference Call 

Hold Conference Call 7.9.2 Hold Conference Call 

Unhold Conference Call 7.9.3 Unhold Conference Call 

Leave Conference Call 7.9.4 Leave Conference Call 

End Conference Call 7.9.5 End Conference Call 
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3.4 Receptionist Office   

The Receptionist Office edition is targeted at a small office environment with a limited 
number of employees.  It supports the standard set of call control features and the 
monitoring of up to eight lines in the directory. 

3.4.1 User Interface  

Figure 9 shows the main interface of Receptionist Office. 
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The Receptionist Office main interface contains the following areas: 

1.  Switchboard panel 

2.  Directory panel 

3.  Options panel 

4.  Control panel 

For information on these areas, see section 5 Receptionist Interface and Setup. 

The Receptionist Office interface also contains the following: 

�  Title bar – Displays the name of your version of Receptionist. 
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�  Menu bar – Contains menu items used to configure various settings and provide 
information about Receptionist. 

The menu items are described in section 6 Menu Bar. 

The menu items that contain information specific to Receptionist Small Business are as 
follows:  Tools – Options, Tools – Call History, View – Company Information, and View – 
Directories.  They are shown in the following figures. 

Figure 10 shows the Receptionist Office Tools – Options dialog box. 
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The Tools – Options dialog box provides the following tabs: 

�  General 

�  Connection 

�  Directories 

�  Theme 

�  Updates 

�  About 

For more information, see section 6.4.2 Tools �  Options. 
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Figure 11 shows the Receptionist Office Tools – Call History dialog box. 
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The Tools – Call History dialog box provides the following tabs: 

�  Dialed Calls 

�  Received Calls 

�  Missed Calls 

For more information, see section 6.4.1 Tools – Call History 

Figure 12 shows the Receptionist Office View menu. 
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The View menu allows you to select directories you want to access from the Contact 
Directory panel. 

For more information on the View menu, see section 6.2 View Menu. 

3.4.2 Call Management Functionality  

The Receptionist Office provides the following call management functions: 

Function Described in Section 

Dial Contact 7.1.1 Dial Contact 

Dial Ad Hoc Number 7.1.2 Dial Ad Hoc Number 

Speed Dial 7.1.3 Speed Dial 

Dial From Call History 7.1.4 Dial from Call History 

Answer Call 7.2 Answer Call 

Hold Call 7.3 Put Call on Hold 

Unhold Call 7.3.2 Unhold Call 

End Call 7.4 End Call  

Blind Call Transfer 7.5.1 Blind Transfer Call 

Supervised Call Transfer 7.5.2 Conduct Supervised Transfer 

Consulted Call Transfer 7.5.3 Conduct Consulted Transfer 

Transfer to Voice Mail 7.5.4 Transfer to Voice Mail 

Directed Call Pickup 7.7 Conduct Directed Call Pickup 

Operator Call Barge-in 7.8 Barge-in on a Call 

Start Conference Call 7.9.1 Start Conference Call 

Hold Conference Call 7.9.2 Hold Conference Call 

Unhold Conference Call 7.9.3 Unhold Conference Call 

Leave Conference Call 7.9.4 Leave Conference Call 

End Conference Call 7.9.5 End Conference Call 
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4 Logging In 

The login procedure is the same for all versions of Receptionist. 

4.1 Web Portal Login 

1) Log in to your BroadWorks web portal. 

2) From the Launch drop-down list at the top right of the BroadSoft logo pane, select the 
Receptionist link.  The link name depends on the Receptionist edition that you have. 
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Receptionist starts and you are automatically logged in. 

4.2 Desktop Login 

If your service provider has configured the Receptionist application to create a desktop 
shortcut on first launch, you can start Receptionist by double-clicking the shortcut on your 
desktop or by selecting it from the Start menu. 

1) Click the Receptionist  shortcut. 

Receptionist starts and you are presented with the following login interface: 
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2) Enter your user name and password. 

You can also select the Remember Me (or Forget Me) and the Remember my 
Password options so that your user name and password are remembered on your 
computer. 

3) Check Sign me in automatically to log in to BroadWorks Call Center automatically 
when you click the Call Center shortcut.  You also have to check Remember Me and 
Remember my Password for automatic sign in to work. 

4) Click Sign In . 
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5 Receptionist Interface and Setup  

This section provides a detailed description of the Receptionist interface.  The elements 
that are available only for a specific version of the Receptionist are identified as such. 

5.1 Switchboard Panel  

The Switchboard panel is located at the top of the Receptionist work area and shows all 
the ongoing calls. 
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The Switchboard panel has the following components (from left to right): 

�  The Link column lets you select the calls to be linked for a Consulted Transfer and 
Three-Way Conference.  To link calls, click in their Link column cell. 

The appearance of a chain link symbol  indicates the activation of this option.  
Clicking in the cell toggles the link option again. 

�  The Line column shows the order that phone calls come in, starting from 1. 

�  The Call To (Called Party) column identifies the party being called by you.  A name is 
typically displayed when the called party is in the Contact directory.  A number is 
displayed for calls to persons not in the Contact directory and most external calls. 

�  The Call From (Calling Party) column identifies the person calling you.  For internal 
calls, this is the name assigned to the extension number in the Contact directory or 
the extension number, if no name has been assigned.  For external calls, it is the 
caller’s number unless the number is blocked (private) or the name is unavailable. 

�  The Status column shows the state of calls on the operator switchboard (phone) and 
is color-coded as follows: 

Call State Display Status 

Active Active 

Held On Hold (00:00) (blinks after 45 seconds) 

Camp On Camped (00:00) (blinks after 45 seconds) 

Remote Held Active 

Ringing In (Remote) Incoming 

Ringing In (Local) Incoming 
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Call State Display Status 

Ringing Out Outgoing 

 
�  The Time column displays the duration of the call, including the Ring Time, Hold Time, 

and Talk Time. 

5.2 Company Notes and Profile Area ( Enterprise Edition )  

The Company Notes and Profile area is located next to the Switchboard panel.  It lets the 
operator modify notes and profile content for a given organization.  Operators can modify 
the content as required.  For more information, see section 10 Keeping Notes (Enterprise 
Edition). 
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5.3 Queue Panel ( Enterprise Edition )  

The Queue panel is located in the top right-hand panel of the main interface and provides 
a listing of all calls in the queue.  You can show and hide the Queue panel by selecting 
View and then Queue from the menu bar. 
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The operator is provided with the following: 

�  Position, queue, name, number, hold, and start of each call in the queue 

�  Ability to receive calls from the queue 

�  Ability to modify the position of calls in the queue 
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The Queue panel includes the following components: 

�  The Position column displays the position of the call in the queue. 

�  The Queue column shows the name of the queue each listed call belongs to. 

�  The Name column displays the name of the caller in the queue. 

�  The Number column displays the number of the caller. 

�  The Hold column is the length of time a call has been in the queue. 

�  The Start column displays the time a call entered the queue. 

You can control the columns that are visible in the Queue panel by selecting and 
deselecting them on the View menu of the Menu bar. 

To show or hide a column, select View from the Menu bar, select Queue Columns, and 
then select or deselect the column you want to make visible or invisible. 

The Queue drop-down list displays the list of queues that appear in the Queue panel.  A 
check mark appears to the left of the queues in the Queue panel. 

The Joined drop-down list determines where you are able to receive calls from the queues 
managed on the Queue tab in the Options dialog box.  You can select “Join” to receive 
calls from the queue or “Unjoin” if you do not want to receive calls from the queue. 

For information on managing queues, see section 8 Managing Queues (Enterprise 
Edition). 
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5.4 Contact Directory Panel  

The Contact Directory panel is located as the third panel of the main interface and 
provides a listing of all contacts available to the operator. 
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5.4.1 Capabilities  

You are provided with the following capabilities: 

�  Contact information 

�  Convenient access to contact extension numbers and voice mail 

�  Ability to view contact status 

�  Ability to search contacts 

�  Ability to add, delete, and edit speed dial contacts 

�  Call Management 
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5.4.1.1 Additional Functionality (Enterprise Edition ) 

Receptionist Enterprise users have the following, additional capabilities: 

�  Access to contact phone numbers 

�  Ability to send e-mails to contacts 

�  Ability to order contacts in an ascending or descending order 

�  Ability to filter ordered contacts using alphabetical indexing 
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�  Ability to maintain and update notes for a contact 

5.4.2 Directory Management Interface   

At the bottom of the Contact Directory panel there are several dialog boxes and buttons 
that assist you in managing directories: 
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�  The Search text box  allows you to enter a string you want to use to 
search for contacts, typically a contact’s name or phone number or part thereof.  The 
search returns all contacts containing the string as part of the selected directory field.  
For example, entering “Ann” and selecting “First Name” from the Search Filter 
Category returns all contacts with the first name “Ann”, but it also returns all contacts 
with first names such as “Anne”, “Marianne”, “Marie Ann”, “Ann Marie”, and so on. 
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�  The Search Filter Category drop-down list  allows the operator to choose 
a directory field for a keyword search.  The value selected from this filter drop-down 
list is the column in which Receptionist searches for the string entered in the Search 
text box, as well as the directory. 

�  The Search button , when clicked, enacts a keyword search based on the 
keyword and the Search fields. 
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�  The Reset button , when clicked, displays the full list of contacts, removing the 
effects of previous searches and filters. 

�  The Add button  allows you to add an entry to the Speed Dials directory.  It is only 
enabled when the Speed Dial directory is selected in the Contact Directory panel. 

�  The Edit button  allows you to edit the entry currently selected in the Contact 
Directory panel.  This button is only enabled for directories in which you have the 
ability to edit contact fields, such as the Speed Dial directory or to add notes to 
contacts in the Contact directory (Enterprise Edition ). 

�  The Delete button  lets you remove the entry currently selected in the Contact 
Directory panel.  This button is only enabled for the Speed Dial directory. 

For information about managing directories, see section 9 Managing Directories. 

5.5 Directories  

The directory tabs at the top of the Contact Directory panel allow you to choose the 
directory you want to appear in the panel. 
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The list of directories you can choose from depends on your version of Receptionist and 
your setup.  Table 4 lists the directories available for each version of Receptionist. 

Directory Name Contents Enterprise Small 
Business 

Office 

BroadWorks 
Contact Directory 

Other subscribers in 
your BroadWorks 
contact directory 

�  �  ��

Group Only 

BroadWorks 
Personal Directory 

All contacts in your 
personal directory on 
the BroadWorks web 
portal 

�  �  �  

Speed Dials 
Directory 

All numbers 
configured for you or 
by you for your Speed 
Dial service 

�  �  �  

Phone Status 
Monitoring 

A list of users, 
configured by the 
administrator, whose 
phone status you are 
currently monitoring 

�  

(Monitoring 
limited to 200 

static and up to 
800 dynamic 

users enterprise- 
wide) 

�  

(Monitoring 
limited to 30 

users 
company- 

wide)�

��

 (Monitoring 
limited to 

eight users 
group-wide) 
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Directory Name Contents Enterprise Small 
Business 

Office 

LDAP Directory All users found in the 
LDAP directory.  The 
directory needs to be 
configured by your 
system administrator.  
Otherwise, it is not 
visible. 

�    

Custom Contact 
Directories 

Created and 
customized by the 
administrator or via 
the search tool 

�    

Outlook Directory All your Outlook 
contacts.  The 
directory needs to be 
enabled via the Tools 
– Options tab. 

�    
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To show or hide directories tabs in the Contact Directory panel, select View and then 
Directories from the menu bar, and then select or deselect directory names. 

5.5.1 Contact Status Information  

The Call Status icon, available in some directories, in both List and Details view, shows 
the contact’s phone on-hook/off-hook state.  The color of the icon is customizable through 
the Tools – Options – Themes dialog box.  The following colors represent the default 
definitions: 

Call Status Icon Description 

Available 
 

Contact phone is on-hook (available to receive a call). 

Busy 
 

Contact phone is off-hook (on a call, busy). 

Ringing 
 

Contact phone is ringing (previously this was a blue 
triangle). 

Do Not Disturb 
 

Contact phone has status set to “DND”. 

Unavailable 
 

Contact phone state is currently unavailable or 
unknown. 

Private 
 

Contact phone state is set to “private”. 

Call Forwarding Always 
 

Contact has the Call Forwarding Always service turned 
on.  By hovering your mouse over the Call Forwarding 
Always contact, you can see the number the contact 
has set the Call Forwarding Always to. 
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5.5.2 Views  

Receptionist has two types of directory views, providing different levels of contact 
information detail. 

�  All versions of Receptionist are equipped with the List view of their directories. 

�  Additionally, Receptionist Enterprise  is provided with the Details view. 

5.5.2.1 List View 

The List view lists all the contacts in the selected directory. 
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Additionally, for some directories, such as Contact Directory and Monitored Contacts, the 
contact’s call status is provided. 

5.5.2.2 Details View (Enterprise Edition ) 

The Details view provides more information for each contact.  The exact details change 
from one directory to another and are listed in the following sections. 
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The View Menu button, at the bottom right of the Contact Directory panel allows you to 
toggle between the two views. 
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5.5.2.2.1 Contact Directory – Details 

The Contact Directory – Details view has the following columns: 

�  The Status column shows the contact’s phone on-hook/off-hook state. 

�  The Last Name column displays the contact’s last name as provisioned by the service 
provider.  Only the group/system administrator can change this information. 

�  The First Name column contains the contact’s first name as provisioned by the 
service provider.  Only the group/system administrator can change this information. 

�  The Phone column represents the contact’s provisioned phone as entered in the 
service provider directory.  Only the group/system administrator may modify this 
information. 

�  The Mobile column shows the contact’s mobile number as provisioned by the service 
provider.  Only the group/system administrator can change this information. 

�  The Department column displays the contact’s corporate department or section as 
provisioned by the service provider.  Only the group/system administrator can change 
this information. 

�  The Contact Notes column allows the operator to modify notes that are specific to a 
contact.  The note is retained for subsequent application sessions. 

5.5.2.2.2 Monitored Contacts – Details 

The Monitored Contacts – Details view has the following columns: 

�  The Status column shows the contact’s phone on-hook/off-hook state. 

�  The Last Name column displays the contact’s last name as provisioned by the service 
provider.  Only the group/system administrator can change this information. 

�  The First Name column contains the contact’s first name as provisioned by the 
service provider.  Only the group/system administrator can change this information. 

�  The Phone column represents the contact’s provisioned phone as entered in the 
service provider directory.  Only the group/system administrator can modify this 
information. 

�  The Mobile column shows the contact’s mobile number as provisioned by the service 
provider.  Only the group/system administrator can change this information. 

�  The Title column displays the contact’s job title as provisioned by the service provider.  
Only the group/system administrator can change this information. 
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�  The Department column displays the contact’s corporate department or section as 
provisioned by the service provider.  Only the group/system administrator can change 
this information. 

5.5.2.2.3 Personal Directory – Details 

The Personal Directory – Details view has the following columns: 

�  The Name column displays the contact’s name as entered in the Personal Phone List 
on the BroadWorks web portal.  You need a web portal account to access the web 
portal. 

�  The Phone column represents the contact’s provisioned phone as entered in the 
Personal Phone List on the BroadWorks web portal.  You need a web portal account 
to access the web portal. 

5.5.2.2.4 Outlook Directory – Details 

The Outlook Directory – Details view has the following columns: 

�  The Full Name column shows the contact’s full name as specified in your Outlook 
contacts.  This information is downloaded from your Outlook. 

�  The Last Name column displays the contact’s last name as specified in your Outlook 
contacts.  This information is downloaded from your Outlook. 

�  The First Name column contains the contact’s first name as specified in your Outlook 
contacts.  This information is downloaded from your Outlook. 

�  The Business column represents the contact’s business phone number as specified in 
your Outlook contacts.  This information is downloaded from your Outlook. 

�  The Mobile column represents the contact’s mobile phone as specified in your 
Outlook contacts.  This information is downloaded from your Outlook. 

5.5.2.2.5 Speed Dial – Details 

The Speed Dial – Details view has the following columns: 

�  The Key column specifies the speed dial code you want to use to dial the contact. 

�  The Phone column contains the contact’s phone number entered by you.  You can 
edit this number at any time, using the Edit button in the Contact Directory panel. 

�  The Description column displays the information that you entered to identify the speed 
dial contact. 

5.5.2.2.6 Custom Directory – Details 

The Custom Directory �  Details view provides the same information as the original 
directory from which it was generated, typically the Contact Directory.  The name of the 
custom directory is assigned by the system and usually reflects its contents.  It can be 
created either by your system administrator or by you, using the Search tool.  For more 
information, see section 9.7 Create Custom Directory from Search Results (Enterprise 
Edition). 
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5.5.2.2.7 LDAP Directory – Details 

The LDAP Directory – Details view provides contact information uploaded from a 
Lightweight Directory Access Protocol (LDAP) server.  The information displayed depends 
on your configuration; however, possible values are:  “Full Name”, “Business Phone”, 
“Extension Number”, “Mobile Phone”, “Home Phone”, and “Email Address”.  It has to be 
enabled and configured by your system administrator. 

5.6 Alphabetical Index Area ( Enterprise Edition )  

The Alphabetical Index area is located to the right of the Contact Directory panel. 

 

�������!*��6��������
��� ���<�1�����

Alphabetical Index can be used to refine a search by clicking the starting letter of the 
contact’s name.  For example, to display all contacts with a first name beginning with the 
letter “M”, click M on the Alphabetical Index. 

5.7 Options Panel  

The Options panel is located as the fourth panel of the main interface.  When the 
Receptionist interface is resized (full screen or otherwise), the Options panel size remains 
unchanged.  This allows for the Contact Directory panel to display a maximum number of 
contacts.  However, the size can be changed manually. 
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The Options panel is used to select call managing options and has the following 
components: 

�  The Extn  button allows you to transfer a call or make a call to the selected contact’s 
extension.  If this icon is grayed out, the contact does not have an extension number 
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associated with the contact’s name in the Contact Directory.  Only the group/system 
administrator can modify this number. 

�  The Phone  button allows you to transfer a call or make a call to the selected contact’s 
phone number.  It is assigned to the same button as Extn  and becomes visible when 
calling a phone number.  Only the group/system administrator can modify this 
number. 

�  The Mobile  button allows you to transfer a call or make a call to the selected contact’s 
mobile phone.  If this icon is grayed out, the contact does not have a mobile number 
associated with the contact’s name in the computer database.  Only the group/system 
administrator can modify this number. 

�  The Voicemail  button allows you to transfer a call to the selected contact’s voice mail.  
If this icon is dull in appearance, the contact does not have voice mail configured.  
Only the group/system administrator can modify this number. 

�  The Other  button, when clicked, displays a dial pad used to enter an ad hoc number.  
It allows you to transfer a call or make a call to another number. 

�  The Message  button (Enterprise Edition ) allows you to send messages via  
e-mail to a contact listed in your Contact Directory (for more information, see section 
11 Messaging Contacts (Enterprise Edition).  If this icon is dull in appearance, the 
contact does not have an e-mail address configured in the company database.  Only 
the group/system administrator can modify this setting. 

�  The Queue button (Enterprise Edition ) allows you to place a call in a queue.  For 
more information on managing queues, see section 8 Managing Queues (Enterprise 
Edition). 
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5.8 Control Panel  

The Control panel is used to execute call actions.  Call actions can also be performed by 
clicking Actions on the Menu bar and selecting the desired function.  When the 
Receptionist interface is resized (full screen or otherwise), the Control panel size remains 
unchanged.  This allows for the Contact Directory panel to display a maximum number of 
contacts.  However, the size can be changed manually. 
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The Control panel is used to execute call actions, and contains the following components, 
grouped by display button: 

�  Dial button group: 

-  The Dial button is used to start the dialing process to the number you have 
selected.  You can make a call to a contact when a contact is highlighted and you 
can make a call to another number when the dial pad has been used.  This button 
is dull in appearance when this action is not an option. 

-  The Send button is used to send messages.  When messaging, the Dial button 
changes to Send. 

�  Answer button group allows you to perform a variety of functions depending on the 
context of the active call.  The following dynamics change the button based on the call 
context: 

-  The Answer  button is enabled for incoming calls and allows you to answer a call. 

-  The Hold Conference  button is enabled when the selected call is in a conference 
and allows you to put the call on hold. 

-  The Unhold Conference  button is enabled when a conference is on hold and 
allows you to return it to the Active state. 

-  The Hold  button is enabled when a call is active and allows you to put it on hold. 

-  The Unhold  button is enabled when a call is on hold and allows you to unhold it. 

�  Group Call Park button group (Enterprise Edition ) 

The Group Call Park  button allows you park a call on a line within a pre-defined hunt 
group. 

�  Transfer button group allows you to perform a variety of functions depending on the 
context of the active call.  The following dynamics change the button based on the call 
context: 

-  The Camp button (Enterprise and Small Business Editions ) allows you to 
camp a call  on the selected contact when the contact is in the Busy call state. 

-  The Uncamp  button (Enterprise Edition ) is enabled when the call is camped. 

-  The Blind Transfer  button is enabled when the selected contact is in the 
Available call state. 

-  The Voicemail  button is enabled when the contact selected is in the Available call 
state. 

-  The Queue Transfer  button (Enterprise Edition ) is enabled when you are 
logged in to a queue and allows you to transfer the call to the queue. 

-  The Consulted Transfer  button is enabled when two call parties are linked on 
the switchboard. 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 44 OF 119�

-  The Leave Conference  button is enabled when a conference is in an Active state 
and you want to exit it. 

�  The Conference button group allows you to perform a variety of control functions, 
depending on the context of the active call.  The following dynamics change the 
button based on the call context: 

-  The Conference  button is enabled when two call parties are linked on the 
switchboard and allows you to start a conference call. 

-  The End Conference  button is enabled when a conference is active and allows 
you to end the conference call. 

-  The Call Pick-Up  button is enabled when the contact selected is in a Ringing Call 
state. 

-  The Call Barge-in  button is enabled when the selected contact is in a Busy Call 
state and allows you to barge in on the call. 

�  The End button allows you to disconnect the selected call. 

For more information on call management functions, see section 7 Managing Calls. 
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6 Menu Bar  

The Menu bar is located at the top of the Receptionist main page.  It has the following 
menu items, described in the following sections:  File, View, Actions, Tools, and Help. 

6.1 File Menu 

The File menu allows you to sign out or exit Receptionist. 
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The File menu items are as follows: 

�  Sign Out signs you out of Receptionist and displays the Login menu so that you can 
login again (possibly as a different user). 

�  Exit signs you out and exits Receptionist. 

6.2 View Menu 

The View menu allows you to select which information you want to be visible in 
Receptionist. 
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The View menu items are as follows: 

�  The Company information (Enterprise Edition ) item allows you to show or hide the 
Company Information panel on the Receptionist main page. 

�  The Directories item allows you to select which directories you want to be visible in 
Receptionist.  The selected directories are displayed as tabs at the top of the Contact 
Directory panel. 
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�  The Queue (Enterprise Edition ) item allows you to show or hide the Queue panel on 
the main interface of Receptionist. 

�  The Queue Columns (Enterprise Edition ) item allows you to select the columns to 
appear in the Queue panel. 

6.3 Actions Menu 

The Actions menu lists all the phone management actions of Receptionist.  Only actions 
applicable at any given moment are active.  All other menu items are grayed out. 

 

�������$0����
�������
��6
����
������

The use of actions is explained in context in the appropriate subsections in section  
7 Managing Calls. 
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6.4 Tools Menu 

The Tools menu contains various tools that help you set up and manage Receptionist. 
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The tools are Call History and Options.  They are described in the following sections. 

6.4.1 Tools – Call History 

The Call History dialog box is used to view and delete the user’s call logs.  The dialog box 
can be displayed from the Menu bar by selecting Tools – Call History. 
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The dialog box in Figure 32 shows all possible call history tabs.  Depending on your 
version of Receptionist, some tabs may be unavailable to you. 
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The following sections describe all the tabs, with those available only in some versions of 
the Receptionist clearly identified. 

6.4.1.1 Dialed Calls Tab  

To see dialed calls, click the Dialed Calls tab. 
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The records contain the following information: 

�  Name is the name of the call recipient for internal numbers (where available from the 
company directory).  It can also be the number of the call recipient for external 
numbers or for internal numbers when no name is available. 

�  Number is the number of the call recipient. 

�  Time is the time of the call. 
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6.4.1.2 Received Calls Tab  

To see received calls, click the Received Calls tab. 
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The records contain the following information: 

�  Name is the name of the caller for internal numbers (where available from the 
company directory).  It can also be the number of the caller for external numbers or for 
internal numbers when no name is available. 

�  Number is the number of the caller. 

�  Time is the time of the call. 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 50 OF 119�

6.4.1.3 Missed Calls Tab  

To see missed calls, click the Missed Calls tab in the Calls History dialog box. 
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The records contain the following information: 

�  Name is the name of the caller for internal numbers (where available from the 
company director).  It can also be the number of the caller for external numbers or for 
internal numbers when no name is available. 

�  Number is the number of the caller. 

�  Time is the time of the call. 
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6.4.1.4 Other Tab (Enterprise Edition )  

Select the Other tab to view your average hold time and the number of times you have 
transferred a call.  Click Refresh  to update the statistics. 
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6.4.1.5 Delete Call History Logs  

You can delete one entry, multiple entries, or all entries in the Call History tab.  To delete 
the call logs, do the following: 

1) Select the call entry by clicking on it with the mouse or holding down TAB and using 
the arrow keys.  For selecting consecutive entries, hold down SHIFT while selecting 
the calls.  If you want to select multiple calls that are not together, hold down CTRL 
and select the desired calls.  To select all the calls in the open dialog, whether that 
includes the dialed, received, or missed calls, click Select All . 
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Alternatively, if you want to delete all of the call history entries, click the Clear All  
button. 
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2) A warning message asks for your confirmation.  Select Yes. 
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The entries are now cleared. 
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6.4.2 Tools �  Options  

The Tools dialog box is used to configure user/service provider settings and preferences.  
The dialog box can be displayed from the Menu bar by selecting Tools and then Options.  
It is available on both the login and main interface pages. 
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The dialog box in Figure 40 displays all Receptionist options.  Depending on your version 
of Receptionist, some options may be unavailable to you.  The following sections describe 
all the options, with options available only to some versions of the Receptionist clearly 
identified. 
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6.4.2.1 General Tab  

The General tab contains miscellaneous features that improve the usability of 
Receptionist. 
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The General Options are as follows: 

�  Auto login when connected to network enables Receptionist to automatically try to re-
connect and log in to the server after you lose your network connection. 

The Alerts are as follows: 

�  Auto switch focus on incoming call enables Receptionist to automatically take window 
focus over other applications when a new incoming call is received. 

The Language options are as follows: 

�  The Language drop-down list allows the option of changing the language from the 
default English (U.S.).  The language options are: 

-  English (U.S.) 
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-  French (France) 

-  German (Germany) 

-  Italian (Italy) 

-  Spanish (Spain) 

-  Spanish (CALA), for Central and Latin America 

-  Simplified Chinese (PRC), for People’s Republic of China 

-  Any custom language the administrator has specified 

Selecting the desired language, click OK and restart Receptionist for the changes to 
take place. 

�  Synchronize language with service profile, when checked, enables Receptionist to 
automatically match the application language to the language set within the 
BroadWorks subscriber’s profile after signing in. 
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6.4.2.2 Connection Tab  

Click on the Connection tab to configure the connection information required to connect to 
your service provider. 
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The Server Connection Information is as follows: 

�  The Host Address is the host name/IP address for service.  This is compulsory and 
can be obtained from the service provider. 

�  The Host Port is the port number for service.  This is compulsory and can be obtained 
from the service provider. 

6.4.2.3 Queues Tab   

Click on the Queues tab to configure the queue credentials required to access queue 
functionality in Receptionist. 
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The Queue Management options are as follows: 

�  Queue is the identification name of the queue.  It is read-only. 

�  Joined displays your queue joined status.  Green is joined.  Red is unjoined. 

�  Manage, when checked, ensures that the queue is visible and can be manipulated. 

The Queue Monitoring Accounts options are as follows: 

�  Queue is the identification name of the queue.  It is read-only. 

�  Monitored displays the login status.  Grey is not logged in.  Yellow means it is 
attempting to log in.  Red shows that login failed.  Green indicates that you are 
currently logged in. 

�  Password is the required queue password. 

�  Save Password saves the encrypted password.  Click to save the password. 

The Queue Activity Archive option is as follows: 
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Archive Frequency allows you to allocate how frequently the Receptionist client call and 
ACD event records are archived.  The options from the drop-down list are Do Not Archive, 
Daily, Weekly, and Monthly. 

The archive is saved at the desired interval as a comma-separated value (CSV) file in the 
following path: 

<Drive>:\Documents and Settings\<Windows_Username>\Application 
Data\BroadSoft\BW Call Center\profiles\<BW_UserID>\statistics where: 

-  Drive is the drive letter where your profile is stored (typically C). 

-  Windows_Username is your Windows user name. 

-  BW_User_ID is your BroadWorks user ID. 

The following events are captured based on activity that occurs on the Receptionist client: 

Statistic Description Allowed Values Example Value 

BroadWorks User 
ID 

BroadWorks user ID String jsmith@abc.net 

Call Center ID Call Center ID for inbound 
queued calls only 

String, null ABCSales 

Availability Operator’s joined state Joined, Not Joined, null Joined 

ACD State Operator’s ACD state.  
Typically operators should 
always be Available.  This 
value is not changeable in 
Receptionist. 

Sign-On, Available, 
Unavailable, Wrap-Up, 
Sign-Out, null 

null 

Call ID ID of the call String, null 192.168.1.5:1 

Call State State of the call Idle, Incoming, Outgoing, 
Active, Held, Remote 
Held, Detached, 
Released, null 

Incoming 

Personality The personality of the call.  
It indicates whether the 
user originated this call or 
whether the call was 
placed to the user. 

Integer (0, 1, 2) 

0 = BroadWorks 
Originator  

1 = Originator 

2 = Terminator 

0 

Remote Name External caller name String or null null 

Remote Number External caller number String or null 5555551234 

Last Redirected 
Name 

Last redirected name String or null Jane Doe 

Last Redirected 
Number 

Last redirected number String or null null 

Time Date stamp of record Long Date/Time Format 2008-04-03 
12:08:17.859 
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6.4.2.4 Day/Night Mode Tab (Enterprise and Small Business Editions)  

The Day/Night Mode tab configures day/night mode call settings.  This is useful to turn on 
at the end of your work day when you want to forward calls either to another number or to 
your voice mail.  This tab is only configured once you have logged in. 
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The Day/Night Mode options are as follows: 

�  The Night mode option turns the night mode on and off. 
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-  Forward calls to forwards incoming calls to the specified phone number.  All calls 
to your extension are directly forwarded to this number. 

-  Forward calls to voice mail option forwards incoming calls to your voice mail.  All 
calls to your extension are directly forwarded to your voice mail.  Your voice mail 
must be set up properly for this to work. 

6.4.2.5 Messaging Tab (Enterprise Edition)  

The Messaging tab allows you to configure e-mail service settings and messaging 
preferences. 
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To be able to send e-mail messages to contacts listed in your directory, you have to check 
the Enable Email Messaging option.  The section that follows the Enable Email Messaging 
option configures your e-mail settings and is available only when the option is selected. 

The options are as follows: 
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�  Enable Email Messaging allows/disallows messaging as a contact option on the 
Options panel.  It is compulsory if you want to have messaging available. 

�  Display Name is the name of the person who is sending the message.  This is the  
e-mail user name and it is compulsory. 

�  Reply-to Address is the mailbox address to which messages in reply are delivered. 

�  Default Subject option specifies a default subject to save you from having to type it in 
each message. 

�  SMTP Host is the compulsory Simple Mail Transfer Protocol (SMTP) mail server host 
address. 

�  SMTP Port is the SMTP mail server port number. 

�  Outgoing SMTP server requires authentication checkbox enables secured SMTP 
support.  It also enables Username and Password fields, explained next. 

�  Username is the username credential used to authenticate outgoing mail.  This field is 
required if Outgoing SMTP server requires authentication is checked. 

�  Password is the password credential used, together with the username to 
authenticate outgoing mail.  The password is stored in an encrypted form. 

�  Mail Type selects the formatting of message content.  By default, messages are sent 
as plain text. 

�  Mail Template allows you to choose a template to use when creating the message. 

6.4.2.6 Directories Tab   

Click on the Directories tab to configure which directory is visible on startup of 
Receptionist. 
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The Directory Options allows you to select the directory you want to appear in the Contact 
Directory panel at startup. 

Click on the Start-Up Directory drop-down list to select the “Last viewed” directory or any 
other directory available to you. 
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6.4.2.7 LDAP Integration Tab   

Receptionist Enterprise supports the retrieval of directory information from LDAP servers 
and displaying them as a tab in the Contact Directory window. 

In most cases, the fields in this tab are predefined by your service provider or system 
administrator and do not need to be modified. 

If you do not know the appropriate settings, contact your service provider or system 
administrator. 
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The following explains the meaning of LDAP Integration tab options: 

�  Enable LDAP Integration determines whether Receptionist provides LDAP directory 
lookup services.  Checking this box enables the controls on the Directory page. 

�  Directory Address specifies the network address of the LDAP directory server. 

�  Port is the port number for the LDAP server.  This is compulsory and can be obtained 
from your system administrator. 

�  Search Base determines the location in the directory server tree that Receptionist 
looks in when executing a search. 

�  Recursive, when checked, searches all sub-trees within the search base until the 
specifications are found. 

�  Use SSL (Secure Sockets Layer) determines whether Receptionist uses SSL to 
connect to the directory server.  Note that enabling SSL may require the use of a 
different port. 

�  Requires Authentication indicates whether Receptionist must provide a user name 
and password to the directory server to conduct searches. 
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�  Authenticated DN is the user name Receptionist uses when connecting to the 
directory server when Requires Authentication is checked. 

�  Authenticated Password corresponds to the Authentication DN. 

�  Search Filter specifies an additional search filter to apply to all directory searches.  For 
example, to include the search criteria in the filter you must include 
(cn=*__SEARCH_TEXT__*).  Alternatively, in another example, 
“(telephoneNumber=*)” restricts search results to users who have a telephone 
number assigned. 

�  Retrieved Attributes is a table that controls the way that Receptionist maps attributes 
returned from the directory server to columns displayed in the list of search results. 

�  In each row of the table, enter an LDAP attribute in the Remote Name column.  In the 
Local Name column, enter a corresponding local attribute.  Typical Remote Name 
values are “cn”, “sn”, “telephoneNumber”, “mobile”, “homePhone”, and “mail”. 
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6.4.2.8 Outlook Integration Tab (Enterprise Edition)  

Click on the Outlook Integration tab to enable or disable the use of Microsoft Outlook with 
Receptionist. 
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�  The Enable Outlook Integration check box, when checked, makes sure that the 
Outlook integration features are activated.  When unchecked, the toolbar is 
unavailable within Outlook and you are unable to dial contacts directly. 

�  The Retrieve contacts from default contact folder only option searches for and 
retrieves contacts stored in the default Contacts folder within Outlook. 

�  The Retrieve all contacts option searches for and retrieves contacts stored in any 
Outlook folder. 

�  Use Outlook contacts as preferred CLID lookup (for incoming calls) when checked, 
uses the information saved in your Outlook contact list when displaying information 
about callers, instead of using group settings or other calling line ID information. 
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6.4.2.9 Theme Tab   

Click on the Theme tab to modify the look and feel of Receptionist. 
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The configuration of the look and feel of Receptionist is categorized as follows: 

�  Global font type 

�  Standard control font style 

�  Panel header font style 

�  Slide panel header font style 

�  Login panel color 

�  Login panel font color 

�  Login panel logo 

�  Login panel background image 

�  Switchboard panel color 
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�  Switchboard panel font color 

�  Contact Directory panel color 

�  Contact Directory panel font color 

�  Alpha index button font style 

�  Contact status icon for “unknown” 

�  Contact status icon for “on hook” 

�  Contact status icon for “off hook” 

�  Contact status icon for “call incoming” 

�  Contact status icon for “do not disturb” 

�  Contact status icon for “call forward always” 

�  Contact status icon for “private” 

�  Options panel color 

�  Options panel font color 

�  Options panel button font style 

�  Dial pad font style 

�  Control panel color 

�  Control panel font color 

�  Control button font style 
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For a selected item, the components may be chosen from the Component drop-down 
menu. 
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Global font type  

Altering this theme component enables you to change the font of all of the text used in 
Receptionist.  This includes numerals and menu items. 

Standard control font style  

Altering this theme component changes the size and font style of the text throughout 
Receptionist.  The size ranges from 8 through 16.  The different types are plain, bold, and 
italic. 

Panel header font style  

Altering this theme component changes the size and type of the text on all the main 
screen panel headers situated to the left of the panels.  The affected panels are the 
Switchboard panel, the Queue panel, the Contact Directory panel, the Options panel, and 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 70 OF 119�

the Control panel.  The size ranges from 8 through 16 and the different types are plain, 
bold, and italic. 

Slide panel header font style  

Altering this theme component changes the size and type of the text on all main screen 
slide panel headers.  The affected components are the Company Notes, the Company 
profile, and the Alphabetical Index slide panel headers.  The size ranges from 8 through 
16 and the different types are plain, bold, and italic. 

Login panel color  

Altering this theme component enables you to change the color of the Login screen 
background.  This is a standard grey unless modified. 

Login panel font color  

Altering this theme component changes the color of the font located on the Login screen.  
The user name, password, and check boxes change to the chosen color. 

The text would ideally be changed to white for darker title bar panel colors or black for 
lighter title bar panel colors.  All you must do is make sure that the color combination you 
decide on does not render the text illegible. 

Login panel logo  

Altering this theme component enables you to change the logo located at the bottom right-
hand corner of the login interface.  This component can only be modified with a GIF, 
JPEG, or PNG graphic file that is approximately 180 x 64 pixels in size. 

Login panel background image  

Altering this theme component enables you to change the login interface background 
image.  This component can only be modified with a GIF or JPEG graphic file that is 
approximately 269 x 272 pixels wide.  The interface automatically scales graphics that are 
smaller or larger than needed. 

Switchboard panel color  

Altering this theme component enables you to modify the background color of the 
Switchboard panel, Company Notes and Profile, and Queue panel.  All other components 
within this panel are set to “black” or “white” percentage transparencies of this panel color.  
When modifying this component, make sure it is of a color depth that allows for legibility of 
the text and other elements within this panel. 

Switchboard panel font color  

Altering this theme component changes the color of the font located on the Switchboard 
panel, Company Notes and Profile, and Queue panel.  The text would ideally be changed 
to white for darker title bar colors or black for lighter title bar colors.  All you must do is 
make sure that the color combination you decide on does not render the text illegible. 

Contact Directory panel color  

Altering this theme component enables you to modify the background color of the Contact 
Directory panel.  All other components within this panel are set to “black” or “white” 
percentage transparencies of this panel color.  When modifying this component, make 
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sure it is of a color depth that allows for legibility of the text and other elements within this 
panel. 

Contact Directory panel font color  

Altering this theme component changes the color of the font located on the Contact 
Directory panel, Alphabetical Index, and Directory tabs.  The text would ideally be 
changed to white for darker title bar colors or black for lighter title bar colors.  All you must 
do is make sure that the color combination you decide on does not render the text illegible. 

Alphabetical index button font style  

Altering this theme component changes the size and type of the text on the Alphabetical 
Index buttons.  The size ranges from 8 through 16 and the different types are plain, bold, 
and italic. 

Contact status icon – “Unknown”  

Altering this theme component changes the image used to show an “unknown” or 
unavailable call.  The standard image is a grey phone.  This component can only be 
modified with a GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Contact status icon – “On Hook”  

Altering this theme component changes the image used to show an “on hook” or available 
call.  The standard image is a green phone.  This component can only be modified with a 
GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Contact status icon – “Off Hook”  

Altering this theme component changes the image used to show an “off-hook” call.  An 
“off-hook” call means the contact is already on a call or is busy.  The standard image is a 
red phone.  This component can only be modified with a GIF or JPEG graphic file that is 
approximately 7 x 16 pixels wide. 

Contact status icon – “Call Incoming”  

Altering this theme component changes the image used to show a “Call incoming” call.  
The standard image is an orange phone.  This component can only be modified with a 
GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Contact status icon – “Do Not Disturb”  

Altering this theme component changes the image used to show a “Do Not Disturb” call.  
“Do Not Disturb” is set by the contact.  The standard image is a stop sign.  This 
component can only be modified with a GIF or JPEG graphic file that is approximately 
7 x 16 pixels wide. 

Contact status icon – “Call Forwarding Always”  

Altering this theme component changes the image used to illustrate a “Call Forwarding 
Always” call.  “Call Forwarding Always” is set by the contact.  The standard image is a stop 
sign.  This component can only be modified with a GIF or JPEG graphic file that is 
approximately 7 x 16 pixels wide. 
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Contact status icon – “Private”  

Altering this theme component changes the image used to illustrate a “Private” call.  A 
“private call” means the contact has chosen to withhold their number.  The standard image 
is a red circle with a white dash through it.  This component can only be modified with a 
GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Options panel color  

Altering this theme component enables you to modify the background color of the Options 
panel.  All other components within this panel are set to “black” or “white” percentage 
transparencies of this panel color.  When modifying this component, make sure it is of a 
color depth that allows for legibility of the text and other elements within this panel. 

Options panel font color  

Altering this theme component changes the color of the font located on the Options panel 
and the buttons.  Inactive buttons are a greyer shade of the color chosen.  The text would 
ideally be changed to white for darker title bar colors or black for lighter title bar colors.  All 
you must do is make sure that the color combination you decide on does not render the 
text illegible. 

Options panel button font style  

Altering this theme component changes the size and type of the text on the Options panel 
buttons.  The size ranges from 8 through 16 and the different types are plain, bold, and 
italic. 

Dial pad font style  

Altering this theme component changes the size and type of the text on the dial pad for the 
Other button.  This comes in to view when Other is clicked once.  The size ranges from 8 
through 16 and the different types are plain, bold, and italic. 

Control panel color  

Altering this theme component enables you to modify the background color of the Control 
panel.  All other components within this panel are set to “black” or “white” percentage 
transparencies of this panel color.  When modifying this component, make sure it is of a 
color depth that allows for legibility of the text and other elements within this panel. 

Control panel font color  

Altering this theme component changes the color of the font located on the Control panel 
and the buttons.  Inactive buttons are a greyer shade of the color chosen.  The text would 
ideally be changed to white for darker title bar colors or black for lighter title bar colors.  All 
you must do is make sure that the color combination you decide on does not render the 
text illegible. 

Control panel button font style  

Altering this theme component changes the size and type of the text on Control panel 
buttons.  The size ranges from 8 through 16 and the different types are plain, bold, and 
italic. 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 73 OF 119�

6.4.2.9.1 Theme Loading and Saving   

The theme refers to how the interface appears, which includes the colors in which the 
various panels, buttons, logos, and text are displayed, the size of each component, and 
the manner in which they are displayed in terms of spacing and size. 

The default theme such as “standard.thm” is used for the visual display of Receptionist, 
and this theme is automatically loaded when the application is turned on. 

If you, as a user, want to apply a different theme to the application, do the following: 

1) Select a theme from the Theme drop down menu. 
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2) Click on Apply  at the bottom right of the Options/Theme dialog box.  The settings of 
the selected theme take effect. 

3) You can create a new theme file by clicking on Save As  at the bottom of the 
Options/Theme dialog box.  This brings up a new dialog box prompting you to enter a 
name for your new theme file. 
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4) After entering the name, click OK.  The theme file is saved. 

5) If you would like to apply this new theme file as your default, select it as explained 
above. 
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6.4.2.9.2 Theme Component Modification  

Color Components 

To make a change to any component, click Change  and make your new selection.  When 
you click Change to change a color component, a dialog box is displayed allowing you to 
select a color.  The only exception to this is the Title Bar Icon Color component, for which 
only two alternatives are available, black and white. 
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There are three color choice tabs available.  The Swatches tab allows you to pick a 
particular color, HSB allows you to change the depth of that color, and RGB allows you to 
further alter that color by changing the percentage of red, green, and blue shades. 
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Image/Graphic Components 

1) Click Change  to change an image component.  A dialog box is displayed allowing you 
to select an image/graphic file from your computer. 
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2) Select a file that you want and click Open.  The selected image file replaces the 
component image being changed. 
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6.4.2.10 About Tab   

Click the About tab in the Call History dialog box to find information about Receptionist. 
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The information displayed is as follows: 

�  BroadWorks Receptionist Version 

�  BroadWorks Receptionist Disclaimer 

The About tab is important in providing information for the purpose of technical support. 

6.5 Help Menu 

The Help menu contains the following items: 

�  User Guide – A link to a PDF version of this guide. 

�  About Receptionist IHS – The same information as the Tools – Options About tab.  
For more information, see section 6.4.2.10 About Tab. 
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7 Managing Calls  

You manage calls using a combination of the panels in a top to bottom workflow style.  
You should be able to distribute calls typically using this workflow for most of the activities 
in the following subsections. 

The following subsections describe the call management functions available in 
Receptionist.  Functions available only in certain versions of Receptionist are identified as 
such. 

7.1 Dialing 

Dialing allows you to make calls to contacts in a variety of ways. 

7.1.1 Dial Contact  

To make a call to a contact: 

1) Find and select the contact you want to call by searching the Contact Directory or any 
other directory where the contact may be listed. 
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2) In the Options panel, select the option you want to use for this contact.  Possible 
options include the extension, mobile, or voice mail.  In most cases, an option (usually 
the contact’s extension) is selected by default.  To change the selected option, simply 
click another option once.  Unavailable options are dull in appearance. 

3) In the Control panel, click Dial.  Alternatively, click Actions  on the Menu bar, and 
select Dial from the drop-down list. 
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The called party phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 
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7.1.2 Dial Ad Hoc Number  

To make a call to an ad hoc number (a person not listed in your Contact Directory): 

1) In the Options panel, click Other .  The dial pad appears. 
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2) Enter the number you want to call either by typing the number on the keyboard or by 
selecting each number in turn from the dial pad using your mouse. 

3) Click the DIAL button on the Control panel.  Alternatively, click Actions  on the Menu 
bar, and select Dial from the drop-down list. 

�
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The called party phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 
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7.1.3 Speed Dial ( Enterprise and Small Business Editions )  

To make a call via Speed Dial, perform the following steps: 

1) In the Contact Directory panel, select the Speed Dial tab.  This displays the Speed 
Dials directory. 
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2) From the directory, select the Speed Dial number you want to use. 

3) In the Control panel, click DIAL.  Alternatively, click Actions  on the Menu bar, and 
select Dial from the drop-down list. 
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The called party’s phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 
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7.1.4 Dial from Call History  

You can initiate a call from Call History, by clicking a phone number in one of the call logs. 

To dial from Call History: 

1) From the Menu bar, select Tools and then Call History. 

2) Select the Call History page you want (Dialed Calls, Received Calls, or Missed Calls). 

When you move the cursor over a telephone number in a call list, the number 
becomes underlined to indicate that it is a hyperlink that can be clicked. 
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3) Click the phone number you want to call. 

The called party’s phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 
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7.2 Answer Call  
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To answer a call: 

1) Select the call you want to answer from the Switchboard panel. 
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2) In the Control panel, click Answer .  Alternatively, click Actions  on the Menu bar, and 
select Answer from the drop-down list. 
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7.3 Put Call on Hold  

You put call on hold using the Hold button.  The call must be already in progress. 

7.3.1 Hold Call  

To place a call on hold: 

1) Select the call you want to put on hold from the Switchboard panel. 
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2) Click Hold  on the Control panel to hold the call.  Alternatively, click Actions on the 
Menu bar, and select Hold from the drop-down list. 
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The call status changes to “On Hold”. 
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7.3.2 Unhold Call  

To take a call off hold: 

1) Select the call you want to take off hold from the Switchboard panel. 
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2) Click Unhold  on the Control panel.  Alternatively, click Actions on the Menu bar, and 
select Unhold from the drop-down list. 
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The call becomes active and the call status on the Switchboard panel changes from 
“On Hold” to “Active”. 
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7.4 End Call  

To end a call: 

1) Select the call you want to end from the Switchboard panel. 
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2) Disconnect the calling party by clicking End on the Control panel.  Alternatively, click 
Actions  on the Menu bar, and select End from the drop-down list. 
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The calling party is disconnected when the End button is clicked. 
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7.5 Transferring Calls 

There are a number of ways in which you can transfer a call to another contact. 

7.5.1 Blind Transfer Call  

A blind transfer occurs when a call is transferred without an introduction.  Calls may be 
blind transferred while active, held, or ringing (in) on your phone.  If a call is ringing (in), the 
blind transfer activity allows the call to be redirected before it is answered.  This can be 
done via “drag and drop” or through the Control panel. 

To conduct a blind transfer using drag and drop: 

1) Click the call you want to transfer from the Switchboard panel with your left mouse 
button.  Your cursor changes to a hand grip to indicate the call is moveable. 
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2) To scroll up or down a list, move the cursor over the corresponding corner of the 
contact directory.  To cancel the move at any time, press Esc. 

3) Drag the call to the target contact in your Contact Directory or Customized Directory, 
and let go of the left mouse button.  The call is now transferred.  If the target contact is 
busy, the call is camped. 

To conduct a blind transfer: 

1) Select the call you want to transfer from the Switchboard panel. 

2) Select the option to which you want to blind transfer the call.  This number may be the 
option for a contact from the Contact Directory, a speed dial, or another number of 
your choice entered using the Other dial pad. 

3) Click Blind Transfer  highlighted on the Control panel.  If the BLIND TRANSFER 
button is not highlighted, click Actions  on the Menu bar, and then select Blind 
Transfer. 
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The call is now transferred and then removed from the Switchboard panel. 
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7.5.2 Conduct Supervised Transfer 

When you have an active inbound call that you want to transfer to another contact, do the 
following: 

1) Make sure that the first call is answered and active. 

2) Dial the number you want to transfer the call over to. 

3) Click the Consulted  Transfer  button on the Control panel to conduct the transfer.  If 
the Consulted Transfer button is not highlighted, click Actions  on the Menu bar, and 
then select Consulted Transfer. 
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7.5.3 Conduct Consulted Transfer  

A consulted transfer allows the operator to announce or introduce the call to the called 
party.  A call may be consult-transferred while active, held, or ringing (out). 

To conduct a consulted transfer: 

1) Dial the contact you want to transfer the call to. 

2) When the call is connected, consult with the called contact. 

3) Link the two calls to be connected together by clicking in the Link column on the 
Switchboard panel.  You must do this for both calls, thereby identifying the calls to link. 

 

�������-,��+���
�������1����� � �2��	���%���
�

4) To transfer the calls, click Consulted Transfer  highlighted on the Control panel.  
Alternatively, click Actions on the Menu bar, and select Consulted Transfer from the 
drop-down list. 
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The call is now transferred and both calls are removed from the Switchboard panel. 
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7.5.4 Transfer to Voice Mail  

To transfer a call to voice mail: 

1) Select the call you want to transfer from the Switchboard panel. 
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2) From the Contact Directory, select the name of the contact with voice mail where you 
want to transfer the call.  Select yourself if you want to transfer the call to your voice 
mail.  
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3) On the Options panel, click Voicemail .  

4) Transfer the call to the contact’s voice mail by clicking Voicemail Transfer  on the 
Control panel.  Alternatively, click Actions  on the Menu bar, and select Voicemail 
Transfer from the drop-down list. 
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7.5.5 Transfer to Queue ( Enterprise Edition )  

To transfer to a queue: 
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1) From the Switchboard panel, select the call to transfer. 
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2) Identify the target queue position.  Click Queue on the Options panel.  A pop-up menu 
appears.  Select Front of Queue to move the call to the front of the queue or Back of 
Queue to move the call to the back of the queue. 
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3) To transfer the call, click Queue Transfer  on the Control panel.  Alternatively, click 
Actions  on the Menu bar, and select Queue Transfer from the drop-down list. 
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7.5.6 Busy Camp On ( Enterprise and Small Business Editions )  

Busy Camp On can only work if the user has Camp On activated and the party the user 
wants to transfer to is busy.  It allows the operator to hold and automatically transfer a call 
to a contact when the contact is available to take the call.  A call can be camped on a 
contact only if the call is active or held and if the status of the destination contact is either 
“Busy” or “Ringing”.  The call can be camped via drag and drop or by using control 
buttons. 

Depending on your settings, you can camp calls on users in your group or enterprise. 

���� �����
'�%����#���
������
�������������������������� 	
�������������



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 89 OF 119�

7.5.6.1 Client Managed Mode 

This mode ensures the call stays on your line.  Thus, you have the option to 
unhold a camped call.  To find out which mode you have, contact your group/system 
administrator. 

To camp a call using drag and drop: 

1) Click the call you want to transfer from the Switchboard panel with your left mouse 
button.  Your cursor changes to a hand grip to indicate the call is moveable. 

2) To cancel the move at any time, press Esc. 

3) Drag the call to the target busy contact in your Contact Directory or Customized 
Directory and let go of the left mouse button.  The call is now camped at the contact’s 
extension or Directory Number (DN) and shows Camped status against the call on the 
Switchboard panel.  The calling party is muted while camped and hears the Music On 
Hold.  Once the contact is ready to take the call (contact status becomes “Online”), the 
call is automatically transferred and is removed from the Switchboard panel. 

To camp a call: 

1) From the Switchboard panel, select the call that you want to camp. 

2) Open a directory in the Contact Directory panel and click the contact that you want to 
camp the call on. 
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3) Click Extn  (or Phone ) on the Options panel. 
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4) Click Camp On  highlighted on the Control panel.  Alternatively, click Actions  on the 
Menu bar, and select Camp-On from the drop-down list. 
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The call is now camped at the contact’s extension or DN and shows Camped status 
against the call on the Switchboard panel.  The calling party is muted while camped 
and hears the Music On Hold.  Once the contact is ready to take the call (contact 
status becomes Online), the call is automatically transferred and is removed from the 
Switchboard panel. 

5) If you want to uncamp the call, select it on the Switchboard panel if you have not done 
this.  Click Uncamp , which should be highlighted on the Control panel.  Alternatively, 
click Actions  on the Menu bar, and select Uncamp from the drop-down list. 
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The call is now uncamped from the destination contact and shows On Hold status on 
the Switchboard panel.  This is useful if, for any reason, you want to retrieve a call 
from being camped. 

7.5.6.2 Service Managed Mode 

This mode ensures that the BroadWorks service manages the camped call.  This 
functionality is only available if you have been assigned this service by your group/system 
administrator. 

To transfer a call to a busy user: 

1) Select the call from the Switchboard panel. 
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2) Select a busy contact from the Contact Directory. 
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3) Click the CAMP ON button.  Alternatively, click Actions  on the Menu bar, and select 
Camp-On from the drop-down list.  Once the call is camped, it is removed from the 
Switchboard panel. 
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The call is transferred after the receiving party becomes available and they are 
alerted. 

If the camped call reaches the designated expiration timer, the call is recalled to your 
device and flagged on the Switchboard panel as “Recalled”. 

7.6 Conduct Group Call Park ( Enterprise Edition ) 

Group Call Park, when selected, searches within a predefined hunt group for an available 
line to park a call.  After a designated time, the call returns to the originating operator.  If 
the parking attempt fails for any reason, the call remains on the Switchboard panel. 

To perform a Group Call Park: 

1) Select an active or held call from the Switchboard panel. 

2) Click the Group Call Park  button.  Alternatively, click Actions .  Then select Group 
Call Park from the drop-down list. 
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3) The parked line shows the following information: 

-  Line No:  The line number is dependent on the other calls on the Switchboard 
panel. 

-  Call To:  This is empty, unless the call was previously diverted. 

-  Call From:  This is the name and number of the original calling party. 

-  Status:  This is parked.  The parked extension is in brackets. 

-  Time:  This is displayed in minutes and seconds (mm:ss). 

If designated, there is a parked announcement. 

4) The call is released after the display time expires or the parked announcement has 
finished and the call is now parked. 

5) After a predefined time, the call is recalled to your device. 

7.7 Conduct Directed Call Pickup  

Directed Call Pickup allows the operator to pick up a call that is incoming on a contact.  
This is useful when you want to answer a call on the contact’s behalf or if the contact is 
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currently not on hand to answer the call.  This functionality is only available if you have 
been assigned this service by your group/system administrator.  Depending on your setup, 
you can conduct directed call pickup for users in your group or for users in the entire 
enterprise. 

To conduct a Directed Call Pickup: 

1) Select a contact who you want to pick up the call for.  The contact’s status must be 
“Ringing”. 

2) Click Call Pick-Up  highlighted on the Control panel.  Alternatively, click Actions  on 
the Menu bar, and select Call Pick-Up from the drop-down list. 

 

3) You answer the call on the contact’s behalf and the Switchboard panel shows a new 
“Active” line representing this call. 

7.8 Barge-in on a Call 

Call Barge-in allows you to barge in on a contact’s call.  This is useful when you want to 
enter an already established call between two other people.  This functionality is only 
available if you have been assigned this service by your group/system administrator.  
Depending on your setup, you can barge in on contacts in your group or enterprise. 

To conduct a call barge-in: 

1) Select a contact who you want to barge in on.  The contact’s status must be “Busy”. 

2) Click Call Barge-In  highlighted on the Control panel.  Alternatively, click Actions  on 
the Menu bar, and select Call Barge-in from the drop-down list. 
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You enter an ongoing call, thereby establishing a Three-Way Conference. 

7.9 Managing Conference Calls  

Click Conference  so you are allowed to participate in Three-Way Conference calls.  The 
button is dull in appearance when this action is not an option.  Alternatively, click Actions  
on the Menu bar, and select Conference from the drop-down list. 
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7.9.1 Start Conference Call  

To start a conference: 

1) Select the calls.  Choose both parties with whom you want to conduct a conference 
from the Switchboard panel. 

2) Link the two calls by clicking on both their “LINK” entries.  One chain link should 
appear in each respective entry. 
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3) On the Control panel, click Conference .  Alternatively, click Actions  on the Menu bar, 
and select Conference from the drop-down list. 
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Both calls become Active. 

7.9.2 Hold Conference Call  

To hold an active conference, click HOLD CONFERENCE on the Control panel.  
Alternatively, click Actions on the Menu bar, and select Hold Conference from the drop-
down list. 
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The conference link icon changes when this button is pressed.  The conference is held. 
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7.9.3 Unhold Conference Call  

To reactivate a held conference: 

When a conference is held, the call status for the parties involved shows On Hold. 
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Click UNHOLD CONFERENCE on the Control panel.  Alternatively, click Actions  on the 
Menu bar, and select Unhold Conference from the drop-down list.  Both call states 
change to Active when the action is complete. 
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7.9.4 Leave Conference Call  

To exit from a conference, click LEAVE CONFERENCE on the Control panel.  
Alternatively, click Actions  on the Menu bar, and select Leave Conference from the drop-
down list. 
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This removes the user from the conference call although the two other parties involved in 
the conference call are still connected.  The two parties are removed from the Switchboard 
panel. 

7.9.5 End Conference Call  

To end a conference call, click END CONFERENCE on the Control panel.  Alternatively, 
click Actions  on the Menu bar, and select End Conference from the drop-down list. 
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The calls are removed from the Switchboard panel and terminated. 
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8 Managing Queues ( Enterprise Edition )  

You manage queues using a combination of the panels in a top to bottom workflow style.  
To manage queues perform the tasks in the following subsections. 

8.1 Configure Queues Settings 

After you log in to Receptionist, you can configure the Queues tab to log in to queues each 
time you log in to Receptionist. 

1) From the Tools menu, select Options.  The Options dialog box appears. 

2) Click the Queues tab. 
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3) Identify your queue availability by checking the Manage box to indicate your 
participation in each queue.  To identify the queues to join: 

�  Check the Manage box for each queue for which you want to control your join 
status, by subsequently using the Joined drop-down list in the Queue panel on 
the main interface. 

�  Type the password in the Password text box. 

�  Check the Save Password check box to save the password. 
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4) Specify the archive settings by checking the archive records and select the frequency 
with which to archive the records from the drop-down list. 

5) Click OK or Apply  to save the changes. 

8.2 Change your Join Status  

To change your status to Joined: 

From the Joined drop-down list, select Joined.  Your status is now available to receive 
calls from the queues configured in the Options – Queues dialog box.  You start to receive 
calls. 

 

��������0$��7�����3�A����8���F�����2�
��

To change your status to Unjoined: 

From the Joined drop-down list, select Unjoin.  Your status is now unavailable to receive 
calls from the queues configured in the Options – Queues dialog box.  You no longer 
receive calls. 

8.3 View Queue Panel  

Managing and joining queues allows you to monitor the queues. 

To view the Queue panel, display the Queue panel by selecting Queue from the View 
menu. 
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8.4 Display Calls in Queue Panel  

You can monitor queues by displaying the calls for those queues in the Queues drop-
down list. 

To display queues, click on the Queue list and check each queue that you want to display 
as configured in the Options – Queues dialog box. 
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8.5 Filter Calls in Queue Panel 

You stop monitoring queues by filtering out the calls for those queues in the Queues drop-
down list. 

To filter out queues, click on the Queue list and uncheck the queue name to filter out all 
calls related to these queues. 
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8.6 Change Position of Calls in Queue  

To change the position of a call in a Queue panel: 

1) Select a call in the Queue panel by clicking on it. 

2) Specify the new position by clicking the POS column corresponding to the selected 
call in the Queue panel.  A drop-down list appears, containing the available positions 
for the call.  Select a position from the list. 

3) Click Apply  to reposition the call.  Click Reset instead to cancel your changes. 
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9 Managing Directories 

The Contact Directory panel in Receptionist allows you to view, search, and edit a variety 
of different types of directories. 

The Status column of the Contact Directory and any custom contact directory shows the 
contact’s phone on-hook/off-hook state.  The color of the state is customizable through the  
Tools – Options – Themes dialog box.  The following colors represent the different 
automated states: 

Status Icon Description 

Green Handset Down 
 

Contact phone is on-hook (available to receive a call) 
(previously this was a green triangle). 

Red Handset Up 
 

Contact phone is off-hook (on a call, busy) 
(previously this was a red triangle). 

Orange Handset Down 
 

Contact phone is ringing 
(previously this was a blue triangle). 

Do Not Disturb 
 

Contact phone has status set to “DND” 
(previously this was an orange triangle). 

Grey Handset Down 
 

Contact phone state is currently unavailable or 
unknown (previously there was no triangle or it was 
blank). 

Private 
 

Contact phone state is set to “private”. 

Call Forwarding Always 
 

Contact has the Call Forwarding Always service turned 
on.  By hovering your mouse over the contact, the user 
can see the phone number the contact has set the Call 
Forward to. 

 

9.1 View Directory  

To view a directory, click View in the Menu bar. 

From the Directories drop-down list, check the directory you want visible.  This includes 
custom contact directories. 

9.2 Hide Directory  

To hide a directory, click View in the Menu bar. 

From the Directories drop-down list, uncheck the directory you want invisible. 

Alternatively, click the x on the Directory tab. 

9.3 Select Directory 

Use the Contact Directory tab list to select the directory displayed in the Contact Directory 
panel. 
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9.4 Order Columns ( Enterprise Edition )  

To order a directory by column: 

1) Click the top of a column in the Contact Directory to arrange the contacts in ascending 
order for that column.  Words are ordered alphabetically; numbers are ordered 
numerically. 

2) Click the column again to arrange the contacts in descending order. 

Ascending 
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Descending 
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9.5 Filter Directory Alphabetically ( Enterprise Edition )  

You can filter a directory alphabetically using the Alphabetical Index, located to the right of 
the Contact Directory panel. 

To filter a directory: 

1) Select a directory you want to filter by clicking its tab at the top of the Contact 
Directory panel. 

2) Click the name of the column by which you want to filter. 

3) In the Alphabetical Index, press the letter by which you want to filter. 
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For example, click M on the Alphabetical Index if you want to display all contacts with 
a first name (or title, or department, if you want to filter by one of those columns) 
beginning with the letter “M”. 

The matching contacts appear in the Contact Directory panel. 

4) To return to the original view, click the letter again. 

9.6 Search Directory  

You can search a directory using the search feature located at the bottom left of the 
Contact Directory panel. 
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To search a directory: 

1) Click the target directory tab at the top of the Contact Directory panel. 

2) Enter a keyword (or part of a keyword) in the Search text box at the bottom left of the 
Contact Directory panel. 
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3) Select a category (directory field) from the Search Filter Category drop-down list.  The 
available categories depend on the directory you are searching.  The default value is 
“All”. 

4) Click Search . 

The results of the search appear in the Contact Directory panel. 

Depending on your setup, Receptionist returns either all the contacts (in the Contact 
Directory), which contain the entered keyword as any part of the selected filter 
(directory columns) or all the contacts that start with the entered keyword. 

-  In the first case (Contains), entering “Ann” and selecting “First Name” from the 
Keyword Search Filter drop-down list returns all contacts with the first name 
“Ann”, but it also returns all contacts with first names such as “Anne”, “Marianne”, 
“Marie Ann”, “Ann Marie”, and so on. 

-  In the second case (Starts With), entering “Ann” and selecting “First Name” 
returns all contact with the first names such as “Ann”, Anne”, and Ann Marie”, but 
not “Marianne” or “Mary Ann”. 

5) To return to the full directory, click Reset. 
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9.7 Create Custom Directory from Search Results ( Enterprise Edition )  

Use the search feature to create a custom directory from search results.  Once created, 
the custom directory is displayed in the Contact Directory panel, and can be used until you 

click the close  button on the custom directory tab. 

To create a custom directory: 

1) Select the directory by clicking its tab at the top of the Contact Directory panel. 

2) Enter a keyword (or part of a keyword) in the Search text-box at the bottom-left of the 
Contact Directory panel. 

3) Select the search category (contact directory column name) from the Search Filter 
Category drop-down list.  The available criteria depend on the directory you are 
searching.  The default value is “All”. 

 

���������!��%����
��8���
���'�3�+���
�� ������
��

4) Press CTRL and click Search . 

The results of the search appear in the Contact Directory panel and the definition of 
this search is appended to the name of the directory on the selected directory tab.  For 
example, a search for the keyword “Engineering” within the Contact Directory would 
display the following: 

Contact Directory:  Engineering 
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9.8 Edit Contact Notes ( Enterprise Edition )  

You can create and edit notes for contacts in the Contact Directory using the Edit button 

, located at the bottom right-hand corner of the Contact Directory panel. 

1) Select the desired contact in the Contact Directory. 

2) Click Edit . 

Receptionist opens a dialog box in which you can edit and save notes for the selected 
contact. 
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3) Edit the notes by adding or changing information as desired. 

4) To save the entry, click OK.  Click Cancel  to exit without saving your changes. 

9.9 Manage Speed Dial Entries  

There are two types of speed dial entries:  Speed Dial 8 and Speed Dial 100.  

�  Speed Dial 8 .  With Speed Dial 8, Receptionist provides eight predefined empty slots, 
numbered 2 through 9.  Speed Dial 8 entries cannot be added or deleted; they can 
only be edited.  You can assign dialing information to a Speed Dial 8 entry, and 
change or delete dialing information by editing the corresponding slot. 

�  Speed Dial 100 .  With Speed Dial 100, you can add up to 100 entries.  You can also 
modify or delete existing Speed Dial 100 entries. 

9.9.1 Edit Speed Dial 8 Entry  

You can assign, modify, or remove dialing information from a Speed Dial 8 entry using the 

Edit  button, located at the bottom right-hand corner of the Contact Directory panel. 

9.9.1.1 Assign Dialing Information to Speed Dial 8 Slot 

1) In the Speed Dials directory, select an empty Speed Dial 8 slot. 

2) Click Edit.  
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3) In the dialog box that appears, enter the phone number and description. 

4) To save the entry, click OK.  Click Cancel  to exit without saving your changes. 

9.9.1.2 Modify or Delete Assigned Speed Dial 8 Entry 

1) In the Speed Dials directory, select an assigned Speed Dial 8 slot. 

2) Click Edit.  

Receptionist opens a dialog box in which you can edit the information. 
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3) Modify or delete information as desired.  Note, however, that you cannot delete the 
phone number and leave the description.  If you try to do that, an error message 
appears. 

4) To save the entry, click OK.  Click Cancel  to exit without saving your changes. 

9.9.2 Add Speed Dial 100 Entry  

You add a Speed Dial 100 entry using the Add button  located at the bottom right-
hand corner of the Contact Directory panel. 

1) Select the Speed Dials Directory tab. 

2) Click Add . 
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Receptionist opens a window in which you enter the information. 
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3) Select a key value from the drop-down list.  The key value determines what numbers 
you have to press on your phone to dial this Speed Dial entry. 

4) Enter the phone and description. 

5) To save the new entry, click OK.  Click Cancel  to exit without creating the new entry. 

9.9.3 Edit Speed Dial 100 Entry  

You can edit an existing Speed Dial 100 entry using the Edit button  located at the 
bottom right-hand corner of the Contact Directory panel. 

1) Select the Speed Dials Directory tab. 

2) Click the desired Speed Dial 100 entry. 

3) Click Edit.  

Receptionist opens a dialog box in which you can modify the information. 
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4) Change the displayed values as desired. 

5) To save the entry, click OK.  Click Cancel  to exit without saving your changes. 
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9.9.4 Delete Speed Dial 100 Entry  

You can delete an existing Speed Dial 100 entry using the Delete button  located at 
the bottom right-hand corner of the Contact Directory panel. 

1) Select the Speed Dials Directory tab. 

2) Click the desired Speed Dial 100 entry. 

3) Click Delete. 

4) Click Yes to confirm your action. 
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10 Keeping Notes ( Enterprise Edition )  

Receptionist incorporates two areas in which the operator can retain different types of 
notes.  Company Notes and Company Profile is only available in Receptionist Enterprise. 

10.1 Company Notes  

Company Notes are located at the right-hand side of the Switchboard panel.  To view the 
Company Notes, go to the View menu, and then check Company Information on the drop-
down list. 
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To modify content in the Company Notes area: 

1) Open the Company Notes area by clicking the slider that contains the words 
COMPANY NOTES. 

2) To add, edit, or delete content, click the text area and type to change content. 

The content is saved and is available when Receptionist is started the next time. 
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10.2 Company Profile  

The Company Profile area is located at the right-hand side of the Switchboard panel.  By 
default, this is hidden.  To view the Company Profile, go to the View menu, and then check 
Company Information on the drop-down list. 
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To modify content in the Company Profile area: 

1) Open the Company Profile area by clicking on the slider that contains the words 
COMPANY PROFILE. 

2) To add, edit, or delete content, click the text area and type to change content.  The 
content is saved and is available when Receptionist is started next time. 
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11 Messaging Contacts ( Enterprise Edition )  

Receptionist allows you to select and message contacts that have e-mail configured in the 
system.  You must also have messaging enabled within Receptionist options.  The 
MESSAGE button lights up when selecting a contact who has e-mail configured.  Clicking 
the MESSAGE button displays a messaging pop-up. 

To message a contact: 

1) Find the contact you want to call and select this contact by clicking on the contact in 
the directory. 
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2) Click MESSAGE.  This displays a message pop-up with two editable fields, one for 
the subject of the message, and one for the body. 
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3) The subject area is pre-populated if you have a default subject for your messages 
configured on the Messaging tab of the Options dialog box.  Otherwise, enter a 
subject for the message you want to send. 

4) Edit the message body by clicking the Main Message Body field and enter the text for 
the message. 

5) Click Send from the Control panel to send the message. 
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12 Glossary  

Name Description 

Active Call This is the call you are currently talking to or dealing with. 

Ringing (In) This is the equivalent to a phone ringing locally. 

Calling Party This is the party who you are receiving a call from. 

Called Party This is the party that you have dialed. 

Music on Hold This is music that is streaming from the service provider for a 
held call. 

Ringing (Out) This is equivalent to a phone ringing on the called party’s 
phone. 
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13 Keyboard Shortcuts  

The following is a listing of keystrokes (shortcut keyboard entries) that are available in 
Receptionist. 

13.1 General Control Keys  

Key Strokes Equivalent Mouse Action Function 

ESCAPE Click OK/CANCEL/EXIT . Exits from the active window. 

Ctrl + P (Enterprise Edition ) Select the Company Notes or 
Company Notes tab. 

Toggles between Company Notes 
and Company Profile. 

 

13.2 Menu Bar Control Keys  

Key Strokes Equivalent Mouse Action Function 

Alt + O Click Tools  and then Options . Displays Options dialog box. 

Alt + R Click Tools  and then Call History . Displays Call History dialog box. 

Alt + H Click Help  and then User  Guide. Opens BroadWorks Receptionist 
User Guide. 

Alt + L Click File and then Logout . Logs out current user from 
Receptionist and returns to login 
screen. 

F11 (Enterprise Edition ) Click Full Screen . Toggles full screen mode on and off 
for the application window. 

 

13.3 Switchboard Control Keys  

Key Strokes Equivalent Mouse Action Function 

Ctrl + F1…F10 Click the Link column for a call on the 
Switchboard panel. 

Displays the link symbol in the Link 
column for the call.  F1 links the first 
call; F2 links the second call, and so 
on.  Two calls must be selected for a 
successful link. 

Shift + F1…F10 Click a call on the Switchboard panel. Select the call.  F1 selects the first 
call; F2 selects the second call, and 
so on. 
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13.4 Contact Directory Control Keys  

Key Strokes Equivalent Mouse Action Function 

Ctrl + F Click the text entry space for keyword 
search. 

Cursor appears in text entry space 
for entry of search keyword. 

Ctrl + R Click on Reset . Resets the search filter and shows 
the current directory. 

Ctrl + Shift + <alpha> Enter a single alphabetical character 
in the Search field and then select a 
filter from the search filter drop-down 
list. 

Apply filter on sorted column. 

Ctrl + S (Enterprise Edition ) Click List View  or Detail View . Toggles between the two displayed 
views of the Contact Directory panel. 

Ctrl + UP/DOWN Select a filter from the Search filter. Traverses through the Search filter 
values. 

UP/DOWN ARROW (Enterprise 
Edition)  

Click each contact in the Contact 
panel in Detail view. 

Selects the contacts on the list. 

UP/DOWN/RIGHT/LEFT ARROW Click each contact on the Contact 
panel in List view. 

Selects the contacts on the list. 

Page UP/DOWN Scroll through the contact list. Pages through the contacts on the 
list. 

 

13.5 Option Control Keys  

Key Strokes Equivalent Mouse Action Function 

<Number Pad /> Click Extension . Selects the extension number of the 
selected contact. 

<Number Pad *> Click Mobile . Selects the mobile number of the 
selected contact. 

<Number Pad -> Click Voice Mail . Selects the voice mail number of the 
selected contact. 

Home (Enterprise Edition ) Click on Message.  Selects the message for the selected 
contact. 

<Number Pad 0,1…9> Click on Number Pad 0, 1,…9 . Enters the corresponding number in 
the dialing pad. 
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13.6 Control Keys  

Key Strokes Equivalent Mouse Action Function 

ENTER Click Dial . Dials the selected number. 

<Number Pad +> Click Transfer . Transfers the selected call. 

Shift + <Number Pad +> (Enterprise 
and Small Business Editions ) 

Click Camp On/Camp Off . Camps on/off the selected call. 

<Number Pad .> Click End. Ends the selected call. 

Space Bar Click Answer  after selecting a call 
on the Switchboard panel, or 
double-click an incoming call on the 
Switchboard panel. 

Answers the longest waiting incoming 
call.  Multiple presses of the space 
bar answers the next call while 
placing the previous active call on 
hold. 

F1…F10 Click Answer  after selecting a call 
on the Switchboard panel, or 
double-click an active call on the 
Switchboard panel. 

Sets a call to “Active” from “Ringing”.  
F1 applies to the first call listed on the 
Switchboard panel; F2 applies to the 
second call, and so on. 

F1…F10 Click Hold  after selecting a call on 
the Switchboard panel, or double-
click an active call on the 
Switchboard panel. 

Sets a call to “On Hold” from “Active”.  
F1 applies to the first call listed on the 
Switchboard panel; F2 applies to the 
second call, and so on. 

F1…F10 Click Unhold  after selecting a call 
on the Switchboard panel, or 
double-click a held call on the 
Switchboard panel. 

Sets a call to “Active” from “On Hold”.  
F1 applies to the first call listed on the 
Switchboard panel; F2 applies to the 
second call, and so on. 

Shift + Ctrl + F1…F10  
OR  
<Number Pad/Del> 

Click a call on the Switchboard 
panel to select it and then click on 
End to end the call. 

Ends the call.  F1 ends the first call; 
F2 ends the second call, and so on. 

<Number Pad +> Click Blind Transfer/Consult 
Transfer/Queue Transfer/Voice 
Mail Transfer  

Blind Transfer/Consultative 
transfer/Queue transfer/Voice Mail 
transfer to selected call or call option. 

Ctrl + <Number Pad +> Click Conference/Call 
Pickup/Barge-in . 

Initiates a conference with linked call 
lines.  Performs Pickup/Barge-in on 
selected contact. 

Ctrl + Alt + <Number Pad +> Click Conference 
Hold/Conference Unhold . 

Toggles a conference from Held to 
Active state. 

Ctrl + Shift + <Number Pad +> Click End Conference . Ends a conference.  Releases all 
parties from the conference. 

Ctrl + Alt + Shift + <Number Pad +> Click Leave Conference . Leaves a conference.  Other parties 
remain connected. 

 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 117 OF 119�

Index 

About tab, Tools, 70 
Actions menu, 43 
Ad hoc number, dial, 72 
Additional resources, 14 
Alphabetical index (Enterprise edition), 39 
Alphabetical index, button font style, 65 
Answer call, 74 
Blind Transfer call, 77 
Busy Camp On call, 80 
Call 

Barge-in, operator, 84 
Blind Transfer, 77 
Busy Camp On, 80 
Consulted Transfer, 78 
End, 76 
Hold, 75 
Supervised Transfer, 78 
Transfer, 77 
Transfer to Queue, 79 
Transfer to Voice Mail, 79 
Unhold, 76 

Call History, 44 
Delete Call History logs, 48 
Dial from, 73 
Dialed Calls tab, 45 
Missed Calls tab, 47 
Other tab, 48 
Received Calls tab, 46 

Call Management functionality 
Enterprise, 19 
Office, 27 
Small Business, 23 

Call Park, group, 83 
Columns, Contact Directory, 92 
Company notes, 99 
Company notes and profile area (Enterprise edition), 

31 
Company profile, 100 
Conference calls 

End, 86 
Hold, 85 
Leave, 86 
Managing, 84 
Start, 84 
Unhold, 86 

Configuring queues settings, 87 
Connection tab, Tools, 52 
Consulted Transfer, 78 
Contact Directory 

Panel, 32 

Panel, capabilities, 32 
Panel, color, 64 
Panel, directory management interface, 33 
Panel, front color, 64 

Contact notes, editing, 95 
Contact status icon 

Call Forwarding Always, 65 
Call Incoming, 65 
Do Not Disturb, 65 
Off Hook, 65 
On Hook, 65 
Private, 65 
Unknown, 65 

Contacts, messaging, 101 
Control keys, 105 

Contact Directory, 104 
General, 103 
Menu bar, 103 
Option, 104 
Switchboard, 103 

Control panel, 40 
Button font style, 66 
Color, 66 
Font color, 66 

Custom Contact Directory, creating, 94 
Day/Night Mode tab, 55 
Delete Call History logs, Call History, 48 
Desktop login, 28 
Dial ad hoc number, 72 
Dial contact, 71 
Dial from Call History, 73 
Dial pad font style, 66 
Dial Speed Dial, 73 
Dialed Calls tab, Call History, 45 
Directed Call Pickup, 83 
Directories, 34 

Contact status information, 35 
Hiding, 91 
Management interface, 33 
Tools, 57 
Viewing, 91 
Views, 35 

Directory (Contact) 
Adding Speed Dial entry, 95 
Control keys, 104 
Creating custom (Enterprise edition), 94 
Editing contact notes (Enterprise edition), 95 
Filter directory alphabetically (Enterprise 

edition), 93 
Managing Speed Dial entries, 95 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 118 OF 119�

Order of columns (Enterprise edition), 92 
Searching, 93 
Selecting directory, 91 

Displaying calls in Queue panel, 89 
End call, 76 
End, conference calls, 86 
Enterprise 

Call Management functionality, 19 
Receptionist, 16 
User interface, 16 

File menu, 42 
Filter directory alphabetically, 93 
Filtering calls, queues, 89 
General control keys, 103 
General tab, Tools, 51 
Global font type, 63 
Glossary, 102 
Group Call Park (Enterprise edition), 83 
Help menu, 70 
Hiding directory, 91 
Hold call, 75 
Hold, conference calls, 85 
Join status, changing, 88 
Keeping notes, 99 
Keyboard shortcuts, 103 
Keys 

Contact Directory control, 104 
Control, 105 
General control, 103 
Menu bar, 103 
Option control, 104 
Switchboard control, 103 

LDAP Integration tab, Tools, 58 
Leave, conference call, 86 
Logging in 

From desktop, 28 
From web portal, 28 

Login panel 
Background image, 64 
Color, 64 
Font color, 64 
Logo, 64 

Managing 
Directories, Contact Directory, 91 
Queues (Enterprise edition), 87 

Managing calls, 71 
Answer call, 74 
Dial ad hoc number, 72 
Dial contact, 71 
Dial from call history, 73 
Dial Speed Dial, 73 
End call, 76 
Putting call on hold, 75 

Transfer call, 77 
Menu bar, 42 

Actions menu, 43 
Control keys, 103 
File menu, 42 
Help menu, 70 
Tools menu, 44 
View menu, 42 

Messaging contacts, 101 
Messaging tab, Tools, 56 
Missed Calls tab, Call History, 47 
Notes 

Contact, 95 
Keeping, 99 

Office 
Call Management functionality, 27 
Receptionist, 24 
User interface, 24 

Operator Call Barge-in, 84 
Option control keys, 104 
Options panel, 39 

Button font style, 66 
Color, 65 
Font color, 66 

Other tab, Call History, 48 
Outlook Integration tab, Tools, 60 
Overview, 15 
Panel header font style, 63 
Pickup, directed call, 83 
Putting call on hold, 75 

Hold call, 75 
Unhold call, 76 

Queue panel 
Displaying calls, 89 
Enterprise edition, 31 
Viewing, 88 

Queues 
Changing join status, 88 
Changing position of calls, 90 
Filtering calls, 89 
Managing, 87 
settings, configure, 87 
Tab, tools, 53 
Transfer to, 79 

Received Calls tab, Call History, 46 
Receptionist 

Editions, 15 
Enterprise, 16 
Office, 24 
Small Business, 20 

Receptionist Interface 
Alphabetical index, 39 
Company notes and profile area, 31 
Contact Directory panel, 32 



 
 

BROADWORKS RECEPTIONIST USER GUIDE 40-CA5604-00 

©2010 BROADSOFT, INC. PAGE 119 OF 119�

Control panel, 40 
Directories, 34 
Options panel, 39 
Overview, 30 
Queue panel, 31 
Switchboard panel, 30 

Receptionist Interface and setup, 30 
Searching in Contact Directory, 93 
Selecting directory, 91 
Settings, queues, 87 
Shortcuts, keyboard, 103 
Side panel header font style, 64 
Small Business 

Call Management functionality, 23 
Receptionist, 20 
User interface, 20 

Speed Dial 100 
Adding, 96 
Deleting, 97 
Editing, 97 

Speed Dial 8, editing, 96 
Speed Dial entries, managing, 95 
Speed Dial entry 

Adding, 95 
Speed Dial 100, adding, 96 
Speed Dial 100, deleting, 97 
Speed Dial 100, editing, 97 
Speed Dial 8, editing, 96 

Speed Dial, (Enterprise and Small Business edition), 
73 

Standard control font style, 63 
Start, conference calls, 84 
Supervised transfer of call, 78 
Switchboard control keys, 103 
Switchboard panel, 30 

Color, 64 
Font color, 64 

Theme component modification, Tools, 68 

Theme loading and saving, Tools, 67 
Theme tab, Tools, 61 
Tools 

About tab, 70 
Connection tab, 52 
Day/Night Mode tab, 55 
Directories tab, 57 
General tab, 51 
LDAP Integration tab, 58 
Messaging tab, 56 
Options, 50 
Outlook Integration tab, 60 
Queues tab, 53 
Theme component modification, 68 
Theme loading and saving, 67 
Theme tab, 61 

Tools menu, 44 
Call History, 44 
Options, 50 

Transfer call, 77 
Blind Transfer, 77 
Busy Camp On (Enterprise and Small Business 

edition), 80 
Consulted Transfer, 78 
Queue (Enterprise edition), 79 
Supervised, 78 
Voice Mail, 79 

Unhold call, 76 
Unhold, conference calls, 86 
User interface 

Enterprise, 16 
Office, 24 
Small Business, 20 

View menu, 42 
Viewing directory, 91 
Viewing Queue panel, 88 
Voice Mail, Transfer to, 79 
Web portal login, 28 

 

 

 

 


